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Introduction to the Tutorial
This tutorial is intended to familiarize you with the basic business profitability modeling 
concepts that are used in SAS Profitability Management software. To complete the 
profitability modeling process, move through this tutorial from beginning to end exactly 
as it is presented.

Even though you may be familiar with the concepts of SAS Profitability Management 
and customer detailed profitability reporting, working through this tutorial will 
familiarize you with the SAS Profitability Management software-the concepts, 
terminology, commands, dialog boxes, and Web reporting tools.

The key to computing segment profitability is the ability to accurately associate costs 
with business segments. The heart of the problem is the difference in how revenue and 
costs are managed and tracked in accounting systems. Revenue is generated by the 
customer. It is usually automatically associated with business segments by sales order, 
invoicing, or funds transfer systems. This makes it relatively easy to perform business 
segment analysis using revenue alone. In contrast, costs are not as easily associated with 
business segments. IT, operations, support, distribution, and administration functions 
generally support many business segments simultaneously.

These shared and indirect costs should ideally be tracked based on logical cause-and-
effect relationships to products, services, channels and customers. Traditional cost 
systems violate this process by using arbitrary cost allocations with broad averages (such 
as the number of customers).

SAS Profitability Management is a highly flexible analysis tool that provides the ability 
to associate a cost and revenue with individual business transactions. Using the software, 
you can calculate profit and loss based on individual transactions. SAS Profitability 
Management provides the level of reporting detail that allows business managers to 
actively manage profit as a performance metric. The product enables business managers 
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to track the profit performance of customer groups or individual customers, product 
groups or individual stock-keeping units (SKUs), channels or specific branches or 
combinations of these dimensions, or others as defined by the customer.

Technical Support
If you encounter problems that you cannot solve by reading the online help or this 
tutorial, refer to the SAS technical support home page at: http://support.sas.com/techsup/
intro.html.

Our support goal is to provide you with the resources you need to answer any questions 
or solve any problems you encounter when using SAS software. We provide a variety of 
tools to help you solve problems on your own and a variety of ways to contact our 
technical support staff when you need help. Free technical support is available to all sites 
licensing SAS software. This includes unlimited telephone support for customers in 
North America. Customers outside of North America should contact their local SAS 
office.

Additional Training and Documentation
Additional training and tutorials can be found at www.sas.com and 
www.bettermanagement.com. Bettermanagement.com offers in-depth domain content 
about selected management concepts that are aimed at improving an organization s 
performance. The Web site is a comprehensive source for performance management 
information and resources including Web casts, white papers, training, and tutorial 
materials. Topics that are covered on the Web include value-based management, 
profitability analysis, strategic enterprise management, activity-based costing and 
management, business intelligence, analytic analysis, scorecarding, and performance 
measurement.

The documentation for SAS Profitability Management can be found at http://
support.sas.com/documentation/onlinedoc/pm/. If there are updates or corrections to this 
tutorial, you can find them there.

Business Requirements for Profitability 
Management

Profitability management is the most significant issue for any corporation. Profitability 
is derived from both analyzing the revenue performance for a given business dimension 
(customer, product, region, channel, customer segment) and analyzing the costs directly 
associated with serving those customers and providing those products. The critical 
challenge for business is to appropriately correlate revenue and costs into a meaningful 
profit and loss statement at the level of detail needed.

In the growing level of corporate complexity and detailed transactional information 
tracing corporate and customer interactions, detailed data analysis can be overwhelming. 
Business managers need a clear tool to deal with millions of detailed transactions and to 
produce an actionable profit and loss statement at a customer detailed level. Businesses 
with millions of customer transactions have the most to gain from implementing SAS 

2 Chapter 1 • Introduction



Profitability Management. This solution is most crucial in the telephone and banking 
industries, where customer differentiation can be most critical to overall corporate 
profitability.

With SAS Profitability Management, decision makers can define the segmentation 
reports that they need on the fly.SAS enables business managers to drill-down into 
revenue and cost categories so they can manage profit as a performance metric.

Reporting Solutions that SAS Profitability 
Management Provides

SAS Profitability Management matches cost and revenue behaviors to detailed 
transactions. The association of the behaviors to the transactions is based upon a wizard-
driven rules engine. The resulting calculated detailed transaction tables are then used as 
source content for a profit and loss statement.

The Web-deployed profit and loss statements that SAS Profitability Management 
provides

• are based on a custom-defined report layout and can support complex calculation 
logic to present your company s reporting needs

• are drillable for increasing levels of detail (revenue breakdowns or contributing costs 
details)

• are drillable based on dimensional hierarchies

• include a summary cube report that can be

• created to include only specific dimensions

• summarized by depths noted in any dimension

• include a detail cube report that can be

• defined with filter logic for a single dimension member

• run on the fly.

Accessibility Features of SAS Profitability 
Management

This product has not been tested for compliance with U.S. Section 508 standards and 
W3C Web content accessibility guidelines. If you have specific questions about the 
accessibility of SAS products, send them to accessibility@sas.com or call SAS 
Technical Support.

Accessibility Features of SAS Profitability Management 3
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Company Background
The Baby Bank is a small sample model focused on the banking industry. The company 
has branches and also services customers through call centers. It performs both retail and 
corporate banking. They are trying to produce customer profitability so that the banking 
managers can view the details of a customer's behavior and profitability value to Baby 
Bank. By having this detailed profit and loss information at the managers fingertips, they 
can make better management decisions on how to service the existing customers and 
what specific types of customers to focus on.

Baby Bank Sample Model
The Baby Bank model consists of the following:

• Five dimensions

1. Channel (3 members: ATM, branch, and call center)

2. Customer (101 members: 50 individuals and 51 businesses)

3. Customer type (4 members: corporate banking, private banking, retail consumer 
banking, and small business banking)

4. Product (14 members: credit products, credit-unsecured, credit-secured, deposit 
products, term, savings, recurring, checking, fee-based products, other products, 
revolving credit products, overdrafts, credit cards, and third-party products)

5. Regions (204 members: by area, country, state, and city)

• Two periods (three levels each: year, quarter, and scenario)
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1. 2006_q4_actual

2. 2006_q4_budget

• Six transaction tables with a total of 4,180 records

ABMCost:

1. Load_Trans_q4a

2. Load_Trans_q4b

CallCenter:

3. CallCenter_q4a

4. CallCenter_q4b

Revenue:

5. Revenue_q4a

6. Revenue_q4b

Profitability Management Goals
Baby Bank is constantly growing its customer base. They have been very effective with 
their new marketing campaign. But it has not been growing in profitability, so the 
previous goals for increasing revenue as the primary goal for Baby Bank are being re-
evaluated. The new focus for Baby Bank is on controlled profitable growth. So the 
profitability of all customers will be evaluated on a detailed basis. Once Baby Bank can 
determine what are the characteristics of profitable customers, internal controls can be 
implemented to decrease the costs associated with high cost activities. The ultimate goal 
is to move existing customers to profitability through behavior changes or increased 
fees. Recruiting more profitable new customers will be keyed on marketing efforts to 
target new customers with behaviors that will be profitable to Baby Bank.

Source Behaviors Model Structure
In the Baby Bank example model, the source content for the behaviors came from an 
activity-based costing model. This ABC model started with general ledger expenses and 
assigned the costs to activities based upon staff efforts required and capital employed. 
Then the activities were traced to cost objects by channel (ATM, branch, call center), by 
product supported (savings, checking, mortgage), and by transaction type (open account, 
check balance, make deposit). These cost objects from ABM by channel, product, and 
transaction type are the source behaviors feeding into the SAS Profitability Management 
model.

In implementing SAS Profitability Management, behavior costs can come from any 
source. ABC is not a required source for SAS Profitability Management. As long as the 
appropriate costs are traced for each behavior at an appropriate level of granularity and 
an appropriate cost basis unit or total has been reliably calculated, it will be a good 
source feed for behaviors into SAS Profitability Management.
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Transaction Data Collection
Operational transaction data tracing customer interactions with the company are critical 
to the effectiveness of the SAS Profitability Management model. This transaction detail 
can come from a multitude of source systems within your corporation. For the Baby 
Bank model. there are three sources for the transactional costs. The first is the 
transaction register for all interactions on an account basis (ATM and branch 
transactions). The second is a register for all call center interactions on a customer and 
product basis. The third source system is a register for all customer revenue tracing fees 
for credit cards and interest payments.

Basic Steps for Building the Model
Using SAS Profitabillty Management involves the following tasks:

1. Populate the input directory

2. Set up the environment

3. Create a new profitability model

4. Define transaction table groups

5. Define rules and associate each with a behavior

6. Calculate the model

7. Define a report hierarchy

8. Define a report layout

9. Prepare reports

10. View the reports

Basic Steps for Building the Model 7
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Chapter 3

Populate the Input Directory

Retrieve the Tutorial Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Create and Populate the Input Directory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Create an Output Directory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Retrieve the Tutorial Data
The data sets for use with the tutorial are provided in a ZIP file. You can access the ZIP 
file from two places:

• installed with the product

• from support.sas.com

Installed with the product

By default the ZIP file, tutorial.zip, is installed in the following directory:

C:\Program Files\SASHome\SASProfitabilityManagementDataTier\2.21\Tutorial

From support.sas.com

1. Go to the SAS Profitability Management Product Documentation Page at http://
support.sas.com/documentation/onlinedoc/pm/index.html. 

2. Download and extract the tutorial data sets. 

Data sets provided

Different data sets are provided for 32–bit and 64–bit systems. The following data sets 
are provided:

association.sas7bdat Holds the relationships between the behaviors 
(where costs reside) and the rules (which 
define the assignment logic to transactions).

behavior.sas7bdat Holds all of the transactions and costs (total or 
unit)

callcenter_q4a.sas7bdat Call center transaction details for the 4th 

quarter actual
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callcenter_q4b.sas7bdat Call center transaction details for the 4th 

quarter budget

dim_channel.sas7bdat Hierarchy definition for the channel 
dimension

dim__customer.sas7bdat Hierarchy definition for the customer 
dimension

dim__custtype.sas7bdat Hierarchy definition for the customer type 
dimension

dim__period.sas7bdat Hierarchy definition for the time period 
dimension

dim__product.sas7bdat Hierarchy definition for the product 
dimension

dim__region.sas7bdat Hierarchy definition for the region dimension

load_trans_q4a.sas7bdat ABMCost transaction details 4th quarter actual

load_trans_q4b.sas7bdat ABMCost transaction details 4th quarter 
budget

reportHierarchy.sas7bdat Report hierarchy defining the drill-down 
detail

reportLayout.sas7bdat Report layout defining the profit and loss 
calculations

revenue_q4a.sas7bdat Revenue transaction details 4th quarter actual

revenue_q4b.sas7bdat Revenue transaction details 4th quarter budget

rules.sas7bdat Definition of the assignment rules logic

For additional details describing the source tables required for SAS Profitability 
Management, please see Chapter 15, “Summary of Model Elements,” on page 121.

Create and Populate the Input Directory
You must create a directory on your SAS Profitability Management server to hold the 
source files for the tutorial. These are the files that you just extracted from tutorial.zip.

1. Create a directory on the SAS Profitability Management server.

For purposes of illustration, we assume that you create and name it as follows:

C:\SAS\ProfitabilityManagement\Bank_In
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You can place the directory where you like and name it what you like. However, do 
not use the system directories under C:\SAS\Lev1\AppData
\SASProfitabilityMgmt2.2\.

2. Give yourself (or whoever is doing the tutorial) read, modify, and write acess to the 
directory. If you have an access problem in doing the tutorial, that this permission 
has probably not been granted.

3. Copy the files from your local machine to the directory that you just created on the 
SAS Profitability Management server.

Create an Output Directory
You must also create a directory on your SAS Profitability Management server to hold 
the calculated transaction tables. This is where SAS OLAP cube generation gets its 
source content for generating cubes. Do not put anything into the output directory.

1. Create a directory on the SAS Profitability Management server.

For purposes of illustration, we assume that you create and name it as follows:

C:\SAS\ProfitabilityManagement\Bank_Out

You can place the directory where you like and name it what you like. However, do 
not use the system directories under C:\SAS\Lev1\AppData
\SASProfitabilityMgmt2.2\.

2. Give yourself (or whoever is doing the tutorial) read, modify, and write acess to the 
directory. If you have an access problem in doing the tutorial, this permission has 
probably not been granted.

Create an Output Directory 11
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Set Up the Environment
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Register Tables in the Input Directory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

Overview
Setting up the SAS Profitability Management environment includes accomplishing the 
following tasks:

• Add users

• Identify input and output directories to SAS Profitability Management

• Register the tables in the input directory

Add Users
Before anyone can begin using SAS Profitability Management, you must use the SAS 
Management Console as an administrator to add a Profitability Management user 
account.

1. Log on to the SAS Management Console as an administrator.

2. Click the Plug-ins tab.

3. Select the Foundation repository.

4. Select Environment Management.

5. Right-click User Manager, and select New ð User.

13



6. Name the new user, and enter other user information on the General tab.

7. Click the Groups and Roles tab, and add Profitability Management Users to the 
list of groups that the user is a member of.

8. Click the Accounts tab, and then click New.

• Enter the new user's User ID, including domain, on the network.

Note: For Windows, the name should be prefixed with the user's domain. For 
UNIX, no prefix is needed.

• Leave the Password field blank (it comes from the Profitability Management 
logon).

• Leave the Confirm Password field blank (it comes from the Profitability 
Management logon).

• Select an authentication domain.

14 Chapter 4 • Set Up the Environment



9. You can leave the Authorization tab blank.

10. Click OK.

The user is created.

Identify Input and Output Directories to 
Profitability Management

Overview
Having created an input and output directory on the server, you must tell SAS 
Profitability Management about each one. To do so, you use SAS Management Console. 
For each directory (input and output) you must create both a library in SAS Management 
Console and a folder that is associated with each library.

Your input and output directories can contain either SAS data sets or database tables. If 
your output directory will contain database tables, then in addition to creating a library 
and its associated folder for the output directory, you must also create a Base SAS 
library and its associated folder to contain the analysis view. The analysis view, which is 
a SAS data set that is created during calculation, is a join of the transaction output tables 
into a single virtual fact table that the OLAP cube is built from. The following table 
summarizes what libraries and folders you must create depending on whether the files in 
your input and output directories are SAS data sets or database tables.

Files are SAS Data Sets Files are Database Tables

Input Library:

a Base SAS library (and its associated folder) 
for an input directory that contains SAS data 
sets

Input Library:

a database library (and its associated folder) 
for an input directory that contains database 
tables
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Files are SAS Data Sets Files are Database Tables

Output Library:

a Base SAS library (and its associated folder) 
for an output directory that contains SAS 
data sets

Output Library:

a database library (and its associated folder) 
for an output directory that contains database 
tables

Analysis Library (optional):

a Base SAS library (and its associated folder) 
for a directory that contains the analysis 
view, which is a SAS data set.

A single library can serve as both the output 
library and the analysis library.

Analysis Library:

a Base SAS library (and its associated folder) 
for an analysis directory that contains the 
analysis view, which is a SAS data set.

Using Base SAS Librairies

Creating Folders
The following instructions apply to using SAS data sets as your input and output files for 
SAS Profitability Management. In this case, your libraries are Base SAS libraries.

To understand folders, it might help to realize that they are independent of repositories. 
One SAS Metadata Server can have multiple repositories, but it has only one set of 
folders. While each library exists in a particular repository, its associated folder is 
independent of any repository.

1. Log on to SAS Management Console as administrator, connecting to your SAS 
Metadata Server.

2. Click Folders.

3. Right-click SAS Folders, and select New Folder.

The New Folder wizard opens. The folder you are creating contains metadata about 
the input (or output) library.

4. Name the folder. For this example, the folder is named PM Data.

In this tutorial, the folder names and locations are only suggestions. You can name 
them as you like and locate them as you like. You should not, however, place folders 
for your input and output libraries under the already-existing Products folder or the 
already-existing System folder, as shown below.
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The important point is that you should have a separate folder for each model and you 
should create at least separate folders for input and output (a separate Analysis folder 
is optional).

5. Click Finish.

6. Create a folder named Baby Bank underneath PM Data. Your folders should now 
appear as follows:

7. Create the following folders underneath Baby Bank:

• Input

• Output

Your folders should now appear as follows:

Identify Input and Output Directories to Profitability Management 17



8. Grant permissions to the input and output libraries to the group, Profitability 
Management Users:

a. Right-click each of the input and output folders in turn and select Properties.

b. Click the Authorzation tab.

c. Grant all but Administer permission to the group, Profitability Management 
Users, as shown:

Creating the Input and Output Libraries
The following instructions apply to using SAS data sets as your input and output files for 
SAS Profitability Management. When you use SAS data sets, your libraries are Base 
SAS libraries.

1. Click the Plug-ins tab.

2. Select the Foundation repository.

3. Expand Data Library Manager.
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4. Right-click Libraries.

5. Click New Library.

6. Select SAS BASE Library as the type of library to be created, and then click Next.

Note: SAS Profitability Management supports any type of library for which you can 
create a libref. For this tutorial, however, we use a SAS Base engine library.

7. Name the library Bank_In.

You can give the library any name you want (eight characters maximum). For 
convience, we give it the same name as the directory. The name is the text that 
appears in the navigation and display areas of SAS Management Console, but it is 
not the libref for the library. The name must be unique within the folder specified in 
the Location field. It must also be unique on all servers where the library is assigned.

8. Specify the location of the library's metadata folder by clicking Browse and 
browsing to the Input folder that you just created.
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Note: You can also create the folder from this window by clicking New folder.

9. Click Next.

10. Select SASApp as the SAS server that can access the library, and then click Next.

Note: Although the window indicates that this step is optional, it is required for SAS 
Profitability Management. And, it is required that you choose SASApp as the 
workspace server.

11. Specify Bank_In as the libref.

The libref is used to reference a library without having to refer to its actual physical 
location.

12. Select the path of the library on the server. This is the actual physical location of the 
library.

Note: If the path does not appear in the list box of available paths, then click New to 
create the path. You can either browse to the path, if it is located on the metadata 
server machine, or you can simply type in the path, if it is on another server, as 
shown in the following:
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For this tutorial we assume that you create the directory at C:\SAS
\ProfitabilityManagement\Bank_In even though the directory can be anywhere on a 
server. However, do not use the system directories under C:\SAS\Lev1\AppData
\SASProfitabilityMgmt2.2\, which are for system use.

13. Click Next.

14. Review the options you selected, and then click Finish.

15. Select View ð Refresh from the menu bar to see the library listed.

16. Grant permissions to the input library to the group, Profitability Management Users:

a. Right-click the library and select Properties.

b. Click the Authorzation tab.

c. Grant all but Administer permission to the group, Profitability Management 
Users, as shown in the following:
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Repeat this process for the output library. Be sure to give it a different name and libref, 
such as Bank_Out, and specify a different directory path—where your output directory 
is located.

Note: You can choose to save the output tables in a database rather than in SAS data 
sets. For information, see the following section.

Using Database Libraries

Overview
SAS Profitability Management supports any type of library for which you can create a 
libref, so your input and output directories can be connected to a database rather than 
containing SAS data sets. Although this tutorial assumes that you are using SAS data 
sets, the following instructions show you how to set up your environment to use database 
tables instead of SAS data sets for your input and output files. The following instructions 
assume that you use an ODBC connection to access your database. Consequently, setting 
up your database environment includes the following tasks:

• creating an ODBC connection

• creating a server

• creating a database library

Creating an ODBC Connection
Do the following to create an ODBC connection:

1. Select Start ð Settings ð Control Panel ð Administrative Tools ð Data Sources 
(ODBC).

The ODBC Data Source Administrator dialog opens.

2. Select the System DSN tab and click Add. 
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The Create New Data Source dialog opens.

3. Select Microsoft Access Driver [*.mdb] and click Finish.

The ODBC Microsoft Access Setup dialog opens.

4. Type a name for your data source, for example PMOut, and click Select.
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The Select Database dialog opens.

5. Browse to the location of your input or output database, and then click OK. Click 
OK again to close the ODBC Data Source Administrator dialog.

The ODBC connection is created.

Creating a Server
After creating the ODBC connection, use SAS Management Console to create a server.

1. Log on to SAS Management Console as administrator, connecting to your SAS 
Metadata Server.

2. On the Plug-ins tab, right-click Server Manager and select New Server.

The New Server wizard opens.

3. Select ODBC Server and click Next.
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4. Name the server, for example ProfManServer, and then click Next.

5. Select ODBC  Microsoft Access as the data source type, and then click Next.
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6. Select Datasrc and type the datasource name, "PMOut", that you specified when 
creating the ODBC connection (be sure to include the quotation marks).

Also specify the database user name and password, and then click Next.

7. Review your options, and then click Finish.
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Creating a Database Library
SAS Profitability Management supports any type of library for which you can create a 
libref, so your input and output libraries can be connected to a database rather than 
containing SAS data sets. The Analysis library, however, can contain only SAS data 
sets. So, if you choose to connect your input and output libraries to a database, you must 
create a separate Analysis library for SAS data sets.

If you want to save your input and output tables in a database library, do the following:

1. Log on to SAS Management Console with the user account that you just created.

2. Click Plug-ins.

3. Select the Foundation repository.

4. Expand Data Library Manager.

5. Right-click Libraries.

6. Click New Library.
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7. Select among the database libraries for the type of library to be created, and then 
click Next.

In this graphic, the ODBC Library is selected, but the following library types are 
also available:

The following table shows the appropriate database library choice for each of the 
possible database types:

Database Appropriate Database Library

DB2 DB2 Library for Unix and PC Hosts

DB2 Library for z/OS Hosts

Microsoft SQL Server ODBC Library (Windows)

OLE DB Library (Windows)

Microsoft SQL Server Library for UNIX 
Hosts

MySql MySQL Library

Oracle Oracle Library
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Database Appropriate Database Library

MS Access OLE DB Library (Windows)

8. Name the library and specify its associated folder, and then click Next.

You can give the library any name you want (eight characters maximum).

9. Select SASApp as the SAS server, and then click Next.

10. Type a Libref name, and then click Next.

The libref is used to reference a library without having to refer to its actual physical 
location.
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11. Specify the Database Server Name that you specified when creating the server and 
specify the connection information. Click Next.

12. Review the library information, and then click Finish.

13. Click View ð Refresh from the menu to see the library listed.

14. Right-click the newly created library and select Properties.
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The Properties window opens.

15. Select the Extended Attributes tab.

16. Click New.

17. In the Field Name column, type DBMSType.

18. In the Value and Description columns, type one of the following pairs depending on 
your database (the Description is optional).

Value Description

MSSQL Microsoft SQL Server

Oracle Oracle

DB2 DB2

MySql MySql

Jet MS Access

The following graphic shows as example in which Microsoft SQL Server is 
specified:

19. Give the group, Profitability Management Users, permission to use this library.
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Register Tables in the Input Directory
The following instructions apply whether you use SAS data sets or database tables. Even 
though you used the operating system or a database management system to copy source 
files into the input directory, SAS does not yet know about them. Use SAS Management 
Console to store metadata regarding the files by registering them. Only structural 
metadata is retained by SAS Management Console, and not the actual content of the 
files.

Note: If you modify the input tables, you must re-register them so that the metadata that 
is maintained by SAS Management Console (column names and data types) is 
updated.

1. Log on to the SAS Management Console as administrator.

2. Click Plug-ins.

3. Select the Foundation repository.

4. Expand Data Library Manager.

5. Expand SAS Libraries.

6. Select the input library, Bank_In.
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7. Select Actions ð Register Tables.

The Register Tables window opens.

Verify that the library information is correct, and click Next.

The log on dialog opens for SASApp.

8. Log on to SASApp.

Note: You should have specified SASApp as the workspace server for this library 
when the library was created. (You can change the server for the library from the 
Assign tab of the Properties window for the library in SAS Management 
Console.)

9. Select the tables to register.
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Note: The name of a SAS table cannot contain a blank space or exceed 32 
characters.

Make sure the location of the registration metadata is correct.

Note:  The location should be the same as was specified when the library was 
created. (You can change the location of the library metadata from the General 
tab of the Properties window for the library in SAS Management Console.)

10. Click Next

11. View the summary of which tables are to be registered, and then click Finish.
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Introduction
Creating a new profitability model involves the following steps:

1. Naming the model and identifying its time dimension

2. Specifying libraries for model output

3. Verifying the location for the model definition

4. Identifying the behavior table for the model

5. Identifying custom dimension tables for the model

Open the Profitability Management Client 
Application

Open the SAS Profitability Management rich client application.
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1. Specify the user ID and password that you created in the SAS Management Console.

2. Specify the SAS Profitability Management server. This is dependent on your 
installation.

3. Specify the port. 8561 is the default for the the SAS Metadata Server.

4. Click Log On.

The SAS Profitability Management rich client application opens.

Open the Model Wizard
1. Select File > Organize Models (or click the Organize Models icon).

2. Click New Model.
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The Organize Models window opens.

Note: If this is the first time that the SAS Profitability Management client has ever been 
invoked, then the Organize Models window opens automatically.

Name the Model and Select the Time Dimension
1. Name the model Baby Bank.

2. Click Select to select the time dimension table.

3. Select DIM_PERIOD as the time dimension table.

We are assuming that the library in which you placed the input files is named 
Bank_In.
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4. Click OK.

The time dimension table defines the time periods in the model. The number of 
periods in a model varies with the reporting needs of a business. The sample time 
dimension table, DIM_PERIOD, is shown in the following graphic (you can click 
the Preview button in the Model wizard to see the table).

5. Click Next.

Select the Output Libraries
1. Specify Baby_Bank as theAnalysis view name.

The analysis view name is used as the name of the database view that is created to 
join the transaction output tables into a single virtual fact table that the OLAP cube is 
built from. By default, the analysis view name is the same as the model name.

2. Specify Bank_Out as the Analysis view library.

For this tutorial, we have created a single output directory, Bank_Out. You can select 
this directory to store the analysis view in.

Note: The Analysis view library must be a SAS Base Engine Library.

3. Also specify Bank_Out as the Output table library.
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While it can be helpful to have separate directories to hold the analysis view and 
calculated transaction tables, for this tutorial we have created a single output 
directory, Bank_Out.

Note: The output table library can be either a SAS Base Engine Library or a 
Database Library. If it is a Database Libary, then it must be separate from the 
Analysis View Library, which is required to be a SAS Base Engine Library. For 
information on using a Database Library, see “Using Database Libraries” on 
page 22.

Assuming, for this tutorial, that you choose the same directory to hold all your 
tutorial output, the dialog appears as follows:

4. Click Next.

Verify the Data Locations for the Model
1. Verify the Server folder where data associated with the model is stored.

2. Verify the Metadata folder where model metadata is stored.

Note: Both storage locations were established during installation. Do not change 
them now. At this point, the dialog box is informational only.

3. Click Next.
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Select the Behavior Table

What is a Behavior Table?
Behaviors, typically, are things that your customers do. For example, the customers of a 
bank can check their balance, make deposits, transfer funds, and make withdrawals.

Each row in a behavior table:

• represents the lowest level of drill-down in an OLAP view " so you should not create 
more behaviors than you expect to view.

• is assigned to a transaction by a rule " so you should create only as many behaviors 
as you have rules for assignment.

The following graphic shows part of the sample behavior table, BEHAVIOR. Notice the 
following:

• Each behavior (each row of the behavior table) has either a non-zero UnitValue, or a 
non-zero TotalValue, but not both.

• The table contains an extra column named "AssignmentRule". All of your source 
tables can have extra columns. This particular field is an extra column containing a 
character string that is used in filtering the table to select a subset of behaviors. 
Sucha field is not required for a standard model.

How to Do It
1. Click Select to select the behavior table for the model.

2. Select BEHAVIOR from the available tables.
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3. Click OK.

4. Identify fields in the behavior table.

A behavior table must contain a field for each of the following: ID, Name, Unit 
Value, Total Value, and Period. You must identify which field is which in the table 
selected.

By default, SAS Profitability Management assumes that these fields are named as 
follows: "ID", "Name", "UnitValue", "TotalValue", and "Time". If fields with those 
names exist in the behavior table, then they are automatically mapped. If the fields 
are named differently, then you must match them manually.

The sample behavior table, BEHAVIOR, contains these fields, so they are mapped 
automatically.

5. Click Next.
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Identify Dimension Tables
1. Click Add to select the custom dimension tables that make up the cube.

2. Select the following dimension tables, and click Add:

• DIM_CHANNEL

• DIM_CUSTOMER

• DIM_CUSTYPE

• DIM_PRODUCT

• DIM_REGION

Note: You can select multiple dimensions by using the Shift or Ctrl key.

3. Click OK.

The dimension tables are added to the model as shown in the following graphic.
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4. Click Finish, and verify that the new model, Baby Bank, is added to the list of 
models.

5. Click Close.
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Define Transaction Table Groups
Transaction tables that share the same column structure are organized into table groups. 
A single Profitability Management model is likely to have multiple table groups. 
Multiple rules likely use the same source table group.

Note: There is one transaction table for each period in a model.

For the Baby Bank model, you define three transaction table groups:

• ABMCost holds the transaction costs that relate to the ATM activities and the 
detailed branch activities.

• CallCenter holds the details of the activities performed at the call center.

• Revenue holds the detailed revenue for all of the customers noted.

Enter these table group names exactly because they must match the names in a pre-
defined rules definition table.
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Define the ABMCost Group

Overview
Defining transaction table groups is a two-part process:

• Define the transaction table group.

• Add transaction tables to the group, and associate each transaction table with a time 
period.

Define the Transaction Table Group
1. Select the Transaction workspace.

Make sure that the Baby Bank model is selected.

2. Click Add table group (or the Add table group icon  ).

The Add Table Group window opens.

3. Name the group ABMCost, and then click Next.
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4. Select LOAD_TRANS_Q4A as the table whose schema serves as the schema for 
the table group.

Note: All the tables in a table group share the same schema, and each table is 
associated with a different time period.

5. Click Next.

6. Specify whether each column in the table is

• Text

• Numeric

• Dimension member (if a dimension member, specify which one).

The specifications for LOAD_TRANS_Q4A should look like those in the following 
graphic:

7. Click Finish.

The table group, ABMCost, is added to the list.
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Add Tables to the Group
1. Click Add transaction tables (making sure that ABMCost is selected).

Or click the icon.

The Add Transaction Tables window opens.

2. Select LOAD_TRANS_Q4A and LOAD_TRANS_Q4B.

3. Click Add.

The tables are added.
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4. Click Next.

The Period window opens.

5. Associate each of the tables with a period as follows:

Table Period

LOAD_TRANS_Q4A Actual > 2006 > 2006_Q4

LOAD_TRANS_Q4B Budget > 2006 > 2006_Q4
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6. Click Finish.

The tables are added to the group.

Transaction Table LOAD_TRANS_Q4A
The following graphic shows the transaction table, LOAD_TRANS_Q4A, and how each 
of its columns is identified as either text, numeric, or a dimension member. You can see 
that each column that is identified as a dimension member contains values that 
correspond to values in the ID field of the corresponding dimension table.
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Define the CallCenter Group

Overview
Repeat the same general process to define a transaction table group named CallCenter.

• Define the transaction table group.

• Add transaction tables to the group, and associate each transaction table with a time 
period.

Define the Transaction Table Group
1. Select the Transaction workspace.

2. Click Add table group.

3. Name the group CallCenter, and then click Next.

4. Select CALLCENTER_Q4A as the table whose schema serves as the schema for 
the table group.

5. Click Next.
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6. By clicking the drop-down arrow for each column, specify whether the column in the 
table is text, numeric, or a dimension member as shown in the following graphic, and 
then click Finish.

The table group, CallCenter, is added to the list.

Add Tables to the Group
1. Click Add transaction tables (making sure that CallCenter is selected).
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2. Add CALLCENTER_Q4A and CALLCENTER_Q4B to the list, and then click 
Next.

3. Associate each of the tables with a period as shown:

4. Click Finish.

The tables are added to the group.
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Transaction Table CALLCENTER_Q4A
The following graphic shows a portion of the contents of the transaction table 
CALLCENTER_Q4A.

Define the Revenue Group
Repeat the same general process to define a transaction table group named Revenue.

Define the Transaction Table Group
1. Click Add table group.
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2. Name the group Revenue, and then click Next.

3. Select REVENUE_Q4A as the table whose schema serves as the schema for the 
table group.

4. Click Next.

5. Specify whether each column in the table is text, numeric, or a dimension member as 
shown in the following graphic, and then click Finish.
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The table group, Revenue, is added to the list.

Add Tables to the Group
1. Click Add transaction tables (making sure that Revenue is selected).

2. Add REVENUE_Q4A and REVENUE_Q4B to the list, and then click Next.
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3. Associate each of the tables with a period as shown:

4. Click Finish.

The tables are added to the group.
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Transaction Table REVENUE_Q4A
The following graphic shows a portion of the contents of the transaction table 
REVENUE_Q4A:

Note: The text field ID in this table is an optional field that is used by a rule for 
filtering.
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Overview
Analysis settings control the formatting of numbers in cube reports. The value field is 
particularly critical to be correctly formatted. The value field displays revenue and cost 
in the profit and loss reporting on the web.

• Select Edit > Analysis Settings.

The Analysis Settings window opens.

Select Periods for the Cube
• Check Include transaction tables from all periods.

The view is created with a join across all available calculated transaction tables.
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The selected periods are included in the view that is used as the source for the OLAP 
cubes and, thus, the reporting.

If you want the cubes and reporting produced to include only a selected set of 
periods, use this dialog box to select the periods and, thus, define the table joins in 
the view.

Each transaction table represents a single period. These calculated transaction tables 
are stored in the output table library. The cubes represent results across multiple 
periods, but the cubes do not need to include every calculated period.

Note: The periods that you select for inclusion in a cube must also be chosen for 
calculation when you calculate the model. Unless a period has been calculated, it 
cannot be included in a cube.

Select Formats for Numeric Measures
1. Click the Measures tab.

The Measures tab lists all numeric properties available to the model. All numerical 
properties are available to be included in profit and loss reporting. This includes:

• all entered numeric properties from the transaction tables

• all the calculated properties:

• Quantity - a numeric value based upon the rules driver formula

• Value - the calculated behavior amounts (revenue or cost)

2. For the VALUE measure, select DOLLAR12.2.

Value is the calculated cost or revenue for a transaction. The method of its 
calculation depends upon whether the behavior table row that is accessed by an 
assignment rule contains a unit value or a total value. See “Calculation - a 
Conceptual View” on page 80.

The default number format is 12.2 (twelve characters with two of them after the 
decimal).
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The following SAS formats are supported:

Note: Not all of the following formats are available on the dropdown list. If a format is 
not on the list, you can type it into the SAS Numeric Format field.

BESTw Best available format with width=w

COMMAw.d Comma and decimal points with width=w and decimal=d

COMMAXw.d Comma and decimal points with width=w and decimal=d (switches the role 
of comma and decimal points)

DOLLARw.d Dollar signs, comma, and decimal points with width=w and decimal=d

DOLLARXw.d Dollar signs, comma, and decimal points with width=w and decimal=d 
(switches the role of comma and decimal points)

EUROw.d Euro signs, comma, and decimal points with width=w and decimal=d

EUROXw.d Euro signs, comma, and decimal points with width=w and decimal=d 
(switches the role of comma and decimal points)

PERCENTw.d Percentage with width=w and decimal=d and a percentage sign

Zw.d Prefixed with zero to get width=w and decimal=d

w.d width=w and decimal=d
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Introduction
An assignment rule associate a behavior with rows in a transaction table. An assignment 
rule is implicitly associated with a single transaction table in a table group - namely, the 
transaction table whose period is specified in the behavior table row with which the rule 
is associated.

Define the First Rule
1. Click the Rules workspace.

2. Select ABMCost as the table group to use the rule.

3. Click Add assignment rule.
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The Add Rule window opens.

4. Name the rule ATM_CHK_Check balance.

5. Click Define.

The Selection Criteria window opens.

6. Select AssignmentRule from the drop-down list of column names to select.

7. Select "=" from the drop-down list of operators.

8. Click Select, and select ATM_CHK_Check balance from the dialog box of 
possible text strings.

The dialog box shows all the possible text strings in the AssignmentRule column of 
the ABMCost table group. (Remember that you selected ABMCost as the table 
group to which this rule applies.)
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After making your selections, the Selection Criteria window should look like the 
following:

9. Click OK.

You return to the Add Assignment Rule window.

10. Select AMT from the drop-down list of values for the driver formula.

The formula uses the value of the AMT column to calculate a value for every row 
chosen by the selection criterion, AssignmentRule = 'ATM_CHK_Check balance'.

AMT represents the number of times a transaction (such as checking one's balance) 
occurred.

Count holds a value of 1 for every transaction. If you need to know, for example, 
how many customers used a specific product, you can filter by product and use the 
Count property to calculate.
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11. Click OK.

The rule is added to the list of rules for the table group ABMCost.

How Rules Work
An assignment rule associates a behavior with rows in a transaction table. An 
assignment rule:

• is associated with one or more rows in a behavior table

• includes selection criteria that specify which rows in a transaction table to include in 
a calculation

• includes a driver formula that specifies what quantity to include in the calculation.

An assignment rule is implicitly associated with a single transaction table in a table 
group - namely, the transaction table whose period is specified in the behavior table row 
with which the rule is associated.
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Define Another Rule
1. Make sure you are in the Rules workspace.

2. Make sure that ABMCost is selected as the table group to use the rule.

3. Click Add assignment rule.

The Add Rule window opens.

4. Name the rule ATM_OTP_Manage Transactions.

5. Click Define.
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The Selection Criteria window opens.

6. Select the dimension Channel from the drop-down list of column names to select.

7. Select is child of from the drop-down list of operators.

The child of" operator is hierarchically driven. By selecting a member of a 
dimension at a point in the hierarchy, you are actually including that specific 
member and all of its children in the dimensional hierarchy. For more information, 
see “Is Child Of” on page 133.

8. Click Select, and select [ATM] from the dialog box of possible values.

After making your selections, the Selection Criteria window should look like the 
following:

9. Click Add New Row.

10. Select the dimension Product as the column to filter on.

11. Select is child of from the drop-down list of operators.

12. Select Other Products from the dialog of possible values.
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13. Click OK.

You return to the Add Assignment Rule window.

14. Select Count from the drop-down list of values for the driver formula.

The formula uses the value of the Count column in calculating a value for every row 
chosen by the selection criteria.

15. Click OK.

The rule is added to the list of rules for the table group ABMCost.
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Import the Remaining Rules
Instead of defining rules one by one, you can put the rule definitions in a file and import 
the file into SAS Profitability Management.

1. Click Import assignment rules.

The Import Rules window opens.

2. Click Select, and select RULES as the table to import.

3. Click OK.

4. Identify fields in the rules table.

A rules import table must contain a field for each of the following: Name, Selection 
Criteria, Driver Formula, and Table Group Name.

By default, SAS Profitability Management assumes that these fields are named as 
follows: "AssignmentRule", "SelectionCriteria", "DriverFormula", and 
"TableGroup". If fields with those names exist in the rules table, then they are 
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automatically mapped. If the fields are named differently, then you must match them 
up manually.

The sample rules table, RULES, contains these fields, so they are mapped 
automatically.

5. Click OK.

The rules are imported.

Note: It is considered an error if a rule already exists. It is not overwritten. A 
duplication error does not prevent other rules from being imported.

Import Table for Rules
The following is a portion of the import table - RULES. Notice that it contains rules 
operating upon all three table groups in the Baby Bank model - ABMCost, CallCenter, 
and Revenue. It is not necessary to create a separate table of rules for each table group.
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Associate Behaviors with Rules
Each behavior must be associated with only one rule. Multiple behaviors can be 
associated with the same rule.

1. Click the Behaviors workspace.

2. Select the behavior 20003 ATM_CHK_Check balance.

3. Click Create a new association.

The Associate Rules window opens.

4. Select the ABMCost table group the table group to which the rule is applied.

5. Make sure that the behaviorABM_CHK_Check balance is selected.

6. Select the rule ABM_CHK_Check balance.

7. Click Associate.

8. Click OK.
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The rule is associated with the behavior, as shown in the behaviors workspace.

Import the Remaining Associations
1. Click Import associations.

The Import Associations window opens.

2. Click Select.

The Select Table dialog opens.

3. Select the ASSOCIATION table to import.
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4. Click OK.

5. Identify fields in the ASSOCIATIONS table.

A rules association table must contain a field for each of the following: Behavior Id, 
Table Group Name, and Rule Name.

By default, SAS Profitability Management assumes that these fields are named as 
follows: -BehaviorId", -TableGroup", and -AssignmentRule". If fields with those 
names exist in the associations table, then they are automatically mapped. If the 
fields are named differently, then you must match them up manually.

The sample table, ASSOCIATIONS, contains these fields, so they are mapped 
automatically.

6. Click OK.

Each behavior is associated with a rule.

Note: If a behavior is already associated with a rule, an error message is issued and 
the association is not replaced. The error does not prevent the rest of the 
associations from being imported.
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Calculate the Model
1. Select Actions > Calculate Model.

The Calculate window opens.

2. Select both periods to be calculated for the model, and then click Next.

Each transaction table represents a single period. When you are calculating a model, 
you do not need to recalculate all of the transaction tables. This is ideal for 
calculations for incremental periods. You can calculate January, for example, and 
then calculate February as a separate calculation. You never need to process a single 
period's transactions more than once as the months proceed through the year.

The summary reports and detail reports reflect transaction tables for time periods that 
have been calculated and that have been selected for cube inclusion in the analysis 
settings (see “Select Periods for the Cube” on page 59) So the generated cubes 
contain the complete details for calculated transaction tables across periods.
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3. Select all three table groups to be calculated for the model, and then click Next.

The Model Calculate Options window opens.

4. Select 1 as the number of concurrent sessions.

SAS Profitability Management can start concurrent sessions to distribute the 
workload across multiple CPUs. One transaction is allocated to each session.

5. Select exception reports to be generated and specify their suffix.

• A transaction exception report flags transaction rows that did not receive an 
assignment during the calculation.

• A behaviors exception report flags behaviors that were not assigned to any 
transaction during the calculation.

6. If you want to generate exception reports, then specify the library to receive them.

7. If you do not want a complete calculation but want only to validate the model, then 
you can select Process limited data from the input transaction tables to validate 
model and specify the number of rows to calculate.

For now, uncheck this option because we want to do a complete calculation.

8. Click Finish.

When the calculation completes, you can view the SAS log.
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9. Click OK to close the results window.

10. Verify the calculation process by reviewing the files created on the server.

Calculation result tables are stored in the directory where you defined the target 
destination LIBNAME. If you remember, we assumed that you created a directory 
on the server for this purpose named C:\SAS\ProfitabilityManagement\Bank_Out.

Log on to the server and view the output files. In addition to creating the calculated 
transaction tables, the generation process creates babybank.sas7bvew. The analysis 
view name is used as the name of the database view that is created to join the 
transaction output tables into a single virtual fact table that the OLAP cube is built 
from.
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Calculation - a Conceptual View

Overview
The following graphic shows a sample transaction table before and after a calculation. 
The calculation has added three new columns to the transaction table in the output 
directory:

Driver Quantity
is the number of units calculated by the driver formula. The calculation is based on 
whether the behavior-table row that is accessed by an assignment rule contains a unit 
value or a total value.

Calculated Value
is the calculated cost for a transaction. The method of its calculation depends upon 
whether the behavior table row that is accessed by an assignment rule contains a unit 
value or a total value.

Behavior
is the ID of the row from the behavior table that is used in the calculation for a 
transaction.

Calculation Using a Unit Value
When a behavior table row contains a unit value, the driver formula calculates the 
number of units that are involved in each transaction chosen by the selection criteria. 
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The number of units appears in the DriverQty field. Then, the cost for that transaction 
(value) is determined by multiplying the number of units (driver quantity) by the unit 
cost (in the behavior table) of the transaction.

The following graphic shows a conceptual example of a calculation using a unit value 
from the behavior table:
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Calculation Using a Total Value
When a behavior table row contains a total value, the driver formula is used to calculate 
the number of units involved in each transaction chosen by the selection criteria. Then, 
the cost for that transaction is determined in the following way:

1. The total number of units for all transactions (chosen by the selection criteria) is 
calculated by adding the number of units (as determined by the driver formula) for 
all the transactions chosen by the selection criteria.

2. The cost per unit is calculated by dividing the total value (in the behavior table row) 
by the total number of units.

3. The cost for each transaction (value) is calculated by multiplying the cost per unit 
times the number of units (as determined by the driver formula) for that transaction.

The following graphic shows a conceptual example of a calculation using a total value 
from the behavior table:
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Output Tables Grow in Length
The number of rows in the calculated transaction table will generally increase. It will 
increase when multiple rules access the same rows in the input transaction table. In this 
case, an additional row is created in the output table each time a new rule accesses the 
same row in the input table. For example, the following graphic shows the second rule 
(ATM_CHK_Requests) selecting the same three rows in the input table as the first rule 
(ATM_CHK_Check balance). The second rule, therefore, adds three more rows to the 
output table-in addition to the three rows added by the first rule.
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Define a Report Hierarchy
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Define a Report Hierarchy
The report hierarchy table defines the dimension hierarchy for drilling into a profit-and-
loss report. A model can have multiple report hierarchies. For more information on 
report hierarchies, see “Report Hierarchy” on page 136

To define a report hierarchy:

1. Select a model.

2. Click the Report Layouts tab in the Reports workspace.

3. Click New report hierarchy (or select File ð New Report Hierarchy.

The Add Report Hierarchy window opens.

4. Name the hierachy Baby Bank Hierarchy.

5. Click Select, and select the REPORTHIERARCHY table.

6. Click Finish.
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The report hierarchy is added to the model.

Behavior Table to Report Hierarchy
Let's take a closer look at the report hierarchy, in particular the relationship between the 
report hierarchy and the behavior table. In the following graphic, you can see that items 
in the behavior table occur at the lowest level in the report hierarchy table. Because the 
hierarchy can have different depths at different places, this means that the behavior table 
items can occur in different columns (different depths) in the report hierarchy table. 
Also, note that intermediate levels can correspond to custom dimensions (for example, 
the channel and product dimensions at levels 3 and 4), but they do not have to. For 
example, interest income and interest expense (in the first six rows of the report 
hierarchy table) do not exist outside the report hierarchy table itself.
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Define a Report Layout

Define a Report Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

Define a Report Layout
A report layout table defines the calculation formula for the profit-and-loss report, and it 
specifies what levels from the report hierarchy are to appear on the initial display of a 
report. A report hierarchy can have multiple report layouts so that you can create 
different reports from the same data. For more information on report layouts, see 
“Report Layout” on page 140.

To define a report layout:

1. Select a model.

2. Click the Report Layouts tab in the Reports workspace.

3. Select the Baby Bank Hierarchy. Each hierarchy can have one or more layouts.

4. Click New report layout (or select File ð New Report Layout).

The Add Report Layout window opens.

5. Name the layout Baby Bank Layout.

6. Click Select, and select the REPORTLAYOUT table to define the layout.
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Note: The report layout must be compatible with its report hierarchy.

7. Click Finish.

The report layout is added to the model.
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Define a Summary Report
A summary report in SAS Profitability Management represents an OLAP cube. In 
defining a summary report, you define the attributes of a cube.

1. Select the Reports tab (making sure that the Baby Bank model is selected).

2. Click the Summary Reports tab.

3. Click New summary report definition.

The New Summary Report Definition window opens.

4. Name the report, for example Baby Bank Summary Report.

5. Select the report hierarchy, Baby Bank Hierarchy, to determine the drill-down 
order of the report.

6. Select the report layout, Baby Bank Layout, to determine the appearance of the 
report.

Note: After you select a report hierarchy, the drop-down list of report layouts lists 
only those layouts belonging to the selected report hierarchy.

7. Click Next.
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8. Select the dimensions and dimension levels to be included in the report.

• Select L3_Quarter for the DIM_PERIOD dimension.

• SelectL5_Profit for the REPORTHIERARCHY dimension.

For each dimension to be included in the summary cube, specify the level of drill-
down allowed.

The default drill-down depth is always the top of the dimension. In this case the top 
of the time dimension is 2006. If no additional drill-down was selected, the summary 
report would hold totaled values for 2006, with no additional detail available to drill 
down.

You can select to include any level of depth defined in your dimensional hierarchy to 
include in your report.

All decisions on the number of dimensions and the depth of drill-down in any 
selected dimension have a dramatic impact on the reporting performance. It is wise 
to limit summary reports to specific areas where business decisions will be made.

It is also wise to produce lots of individual summary reports meeting specific 
managers needs focused upon specific dimensions rather than creating an all-
encompassing summary report that has all dimensions and all drill-down levels.

9. Click Next.

10. Select VALUE as a measure to be included in the report.

The VALUE property is the default. It is the calculated cost for a transaction.
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All numeric properties are available for inclusion in a summary report. The 
following are available:

• Source table transactions numeric properties, by source table group:

• ABMCost (AMT, Count)

• CallCenter (communication, complaints, count, crossSell, inquiry, offer, 
requests)

• Revenue (AMT)

• Calculated results

• Quantity - the result of the rules driver formula noted on each row of the 
transaction tables based on behaviors.

• Value - the calculated result for the behavior source (revenue and costs) 
applied to the transaction details based on the rules defined. The method of 
its calculation depends upon whether thebehavior tablerow that is accessed 
by an assignmentrulecontains a unit value or a total value, as we shall see in 
greater length in “Calculation - a Conceptual View” on page 80.

11. Click Finish. The new report is added to the list of summary reports.

12. Select the new report in the list of summary reports, and then click Generate cube.
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The cube is generated.

Define a Detail Report
Detail reports produce a report based on a single dimension and by filtering a single 
value in that dimension. Detail reports are run from the SAS Profitability Management 
Web Client and create a cube on the fly.

1. Select the Reports tab (and make sure that the Baby Bank model is selected).

2. Click the Detail Reports tab.

3. Click New detail report definition.
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The New Detail Report Definition window opens.

4. Select CustID as the column to be featured in the detail report.

5. Select the report hierarchy, Baby Bank Hierarchy, containing the column.

6. Select the report layout, Baby Bank Layout, to determine the appearance of the 
report.

Note: After you select a report hierarchy, the drop-down list of report layouts lists 
only those layouts belonging to the selected report hierarchy.

When defining a detail report, you should choose the dimension that will most 
uniquely filter the result. A detail report results in a cube created on the fly. Selection 
logic is processed to filter the starting transactional content to the single customer 
selected.

The goal for quick reporting response time is to try to filter your result such that the 
selected answer has fewer than 1,000 records. So, while there are other dimensions 
in the model, it would be unwise to select any dimension other than customer, 
because the filtered results would be more than 1,000 records.

7. Click Next.

8. Select the dimensions and dimension levels to be included in the report.

• Select L3_Quarter for the DIM_PERIOD dimension.

• SelectL5_Profit for the REPORTHIERARCHY dimension.
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9. Click Next.

10. Select VALUE as a measure to be included in the report.

The VALUE property is the default. It is the calculated cost for a transaction.

All of the numeric properties are available to be included in a report.

11. Click Finish.

The system processes all of the calculated transaction tables and adds an index for 
the dimension you have selected for detailed reporting. The SAS log notes that a 
simple index has been created. A dialog box displays the results.
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12. Click OK.

The report definition is added to the list of available detail reports. The list of detail 
reports is the same list that will be available in the Web Report client.

13. Select File > Exit to close the application.

You are now finished working with the SAS Profitability Management rich client.
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Viewing Reports on the Web
After using the SAS Profitability Management rich client to calculate a model and 
generate reports, you can view the reports on the Web. Anyone with a browser and 
access to the Web can view the reports. You use the SAS Profitability Management Web 
application to display a list of summary and detail reports available for viewing. Once 
you choose a report to view, SAS Web Report Studio is launched for you to view the 
report and edit it if you want. You can access SAS Web Report Studio help by selecting 
Help from the SAS Web Report Studio menu (not the browser menu). You can also 
view SAS Web Report Studio product documentation at http://
support.sas.com/documentation/onlinedoc/wrs/.

View the Summary Report
A summary report allows you to navigate all the dimensions of a SAS Profitability 
Management model.

Open the Baby Bank Report
1. Log on to the SAS Profitabilty Management Web application.

Access it at: http://<<your web server>>:8080/SASProfitability/.
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The user name and password you defined earlier using SAS Management Console— 
the same user name you have used up to now in accessing the SAS Profitability 
Management rich client.

SAS Web Report Studio opens at the Summary Report tab.

2. Select the Baby Bank model and click the Baby Bank cube.

The Baby Bank Summary Report opens in SAS Web Report Studio.
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The profit and loss statement is displayed in table format. By default, the display shows:

Rows
which are determined by the combination of the report layout table and the report 
hierarchy table.

Columns
which represent the time period dimension.

Note: Drag the column borders to resize the columns.

See More Columns of Data
See more detail in the time dimension by expanding the columns.

1. Click the plus sign next to Actual and next to Budget to expand both columns.

2. Click the plus sign next to 2006 to expand the year.

You should see a column for the actual results for the fourth quarter of 2006, as 
shown in the following graphic:
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Note: You click the plus sign to expand, and you click the down-arrow to drill 
down.

• Drilling down  replaces the current header with the next lower-level header.

• Expanding  shows the next lower-level header, and leaves the current header in 
place.

After expanding or drilling down, you can navigate in the opposite direction 
(collapsing) by clicking the minus sign.

See More Rows of Data
1. Click the plus sign next to Sales and Marketing Effort to expand the row.

Click the plus sign next to Cost to Retain to expand it.
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2. Continue clicking the plus sign to fully expand that branch of the Sales and 
Marketing Effort. Your display should look like the following:

The levels available to drill down to additional detail in the cube depend on the number 
of dimension levels in the dimension hierarchy and the number of dimension levels that 
you select in the definition of the summary cube. For more information, see “Report 
Hierarchy” on page 136 and “Report Layout” on page 140.

Filter Data
You can select specific values to display using a filter.

1. Right-click the numeric columns in the report and select Filter and Rank from the 
drop-down menu.

The Filter and Rank dialog opens.

2. Select REPORTHIERARCHYSet to filter the report by its rows, and click Filter.

Then select the following rows (you will have to scroll to select them all), and click 
OK:
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• Direct Product

• Total Interest Income

• Total Interest Expense

• Net Interest Income

• Net Funds

• Total Non Interest Income

• Total Non Interest Expense

• Provision For Losses

• Relationship Management

• Sales and Marketing Effort

• Servicing Effort

Your report should look like the following. It is filtered to show only the rows that 
you have selected.
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3. Clear the filter by doing the following:

a. Right-click the numeric columns in the report and select Filter and Rank from 
the drop-down menu.

b. Select REPORTHIERARCHYSet.

c. Select No Filter (show all values).

d. Click OK.

Display Percentages
You can easily display the percentages for the different categories of income and 
expense.

1. Click the Edit tab.

2. Right-click the Table area and select Percent of Total.
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A warning message appears telling you that you cannot display percentages without 
first changing the section from synchronized to desynchronized.

Note: By default, OLAP data is synchronized.

3. Click OK to change to desynchronized. Then right-click the Table icon again and 
select Percent of Total. 

The Percent of Total dialog box opens.

4. Specify the following, and then click Add:

Field Value

For measure Value

Show percent of Column Total

Label Percent
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5. Click OK to close the Percent of Total dialog box.

The following report is displayed:

Add a Bar Chart to the Report
You can add bar charts and other graphs to your report. To illustrate this, let's first start 
over with a fresh view of the summary report.
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1. Click Profitability Management at the top of the window to start over.

The list of available summary reports appears.

2. Click Baby Bank Summary Report.

The Baby Bank Summary Report opens.

3. Click the Edit tab.

4. Click the down arrow under Table of Contents and select Insert a New Section.

The New Section window opens. Click OK to accept the defaults.
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5. Drag the Bar Chart icon ( ) and drop it onto the report area.

6. Under Section Data, choose Select Data.

The Select Data window opens.

7. Select Value and REPORTHIERARCHYSet, and then click OK.
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8. Click the View tab to see the resulting bar chart.

Customize the Bar Chart
1. Right-click the bar chart and select Properties.
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The Properties window opens.

2. From the General tab, select Fixed Size and Medium for the graph size.

3. Click the Bar tab and select Horizontal bars.
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4. Click the Axis tab and select Tahoma 10 point for both labels and values.

5. Click OK.

The bar chart is redrawn to your specifications.
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Save the Report
When you have a report layout that you believe is useful, save it.

1. Select File > Save As.

2. Name the view, for example, Baby Bank Bar Chart, and then click OK.

The view is saved and can be opened again and shared with others for review.

Note: If the cube for your summary report is regenerated in the SAS Profitability 
Management rich client, then your saved view must be refreshed to display the 
new content.
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Add a Custom Dimension
So far we haven't used any of the custom dimensions that are included in the report. To 
illustrate adding a custom dimension, let's first start over again with a fresh view of the 
summary report.

1. Click Profitability Management at the top of the window to start over.

2. Open the Baby Bank summary report.

3. Click the Edit tab, and then select Options ð Select Data.

The Select Data window opens.

4. Select Dim Region and move it to the list of Selected data items on the right side of 
the window. Then click OK.

Note: For the custom dimensions to be available for selection, you must have chosen 
to include the dimensions in the generated cube as shown in cube Properties 
window below.
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5. Click the View tab to see the resulting table. Notice the additional column L1_Area.

6. Right-click L1_Area and select Move ð L1_Area to Left.

The L1_Area column is moved to the left of the REPORTHIERARCHYSet.

7. Right-click Asia Pacific and select Isolate Asia Pacific.
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8. Click the down arrow next to Asia Pacific to drill down.

9. Continue drilling down until you reach the bottom of the region hierarchy. You can 
see the results for Sydney, which you would not be able to see without adding the 
region dimension to the report.

View the Detail Report
1. Click Profitability Management at the top of the window to return to the SAS 

Profitability Management Web workspace.

2. Click the Detail Reports tab.

3. Select the CustID detail report that you defined previously (for the Baby Bank 
model).

4. Type 00018 in the Search For field to report on that customer, and then click View.
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The report for customer 00018 is displayed.

Notice that this report contains fewer rows than the summary report. And, if you open 
the detail report for customer 00040, notice that it contains a different number of rows 
again as shown in the following graphic:
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What accounts for the difference is that rows with no value to show are suppressed. To 
show rows with no values, select Data ð Include Members with Only Missing 
Values. If you don't select Include Members with Only Missing Values, then rows 
with no data are suppressed.
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On review of the customer's profit and loss statement, you can see the details of her 
relationship with Baby Bank:

• She has a credit card and a loan and has been paying a significant amount of credit 
card interest.

• She has also been paying a lot of unsecured loan interest income, but she does not 
have a mortgage.

• She might be a prime target for a marketing communication for a second mortgage to 
consolidate her existing debts.

• She does not have any interest expense, which indicates that her savings, CDs, and 
investments are not with Baby Bank. So she might be a prime target for marketing 
those products.

• When you look at the bottom line, you see that customer 00018, Lynn York, is a very 
profitable customer for Baby Bank.
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Data Requirements for the Model
The following graphic shows the development sequence in SAS Profitability 
Management from the input of various data tables to the output of OLAP cubes. A 
detailed description of each of the input tables follows in this chapter.

For all data tables, perform data validation before the content is loaded into SAS 
Profitability Management. Review source tables to eliminate special characters. The 
following list contains the reserved characters to remove. These characters are not valid 
in cubes, where profit and loss reporting is done:

. , ; ' ` : ? * & % $ ! - + = ( ) [ ] { } / \.

Behavior Table
The behavior source table holds all of the content to provide the cost and the revenue 
values that will be assigned to the transactional volumes based upon the defined rules. 
Each row in a behavior table

• represents the lowest level of drill down in an OLAP view - so you should not create 
more behaviors than you expect to view.

• is assigned to a transaction by a rule - so you should create only as many behaviors 
as you have rules for assignment.

• must be represented in the hierarchy table. The behavior table represents the leaf 
nodes of the hierarchy. The hiearchy table defines the parent nodes.

Note: The following message received during cube generation ERROR: More 
unique keys were detected in the fact table than in the dimension table for the 
<hierarchy> dimension indicates that some behavior table rows are missing from 
the hierarchy dimension.
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The behavior table contains the following fields:

Name

Maximum

Length Description

Time Char 32 The period for the transaction cost

ID Char 32 The ID for the behavior

Name Char 32 The name of the behavior

TotalValue Num 8 The total source amount to be divided

UnitValue Num 8 The unit cost for each transaction with this source

Note:

• Only one of the UnitValue and TotalValue columns can contain a non-zero value 
for any row of the behavior table.

• The order of the columns is arbitrary (you identify the columns during model 
definition).

• The name of the columns is arbitrary (but, if you use these names, they are 
mapped automatically).

• Different behaviors can have the same ID. This is frequently the case when the 
behaviors represent different time periods. Because rules are attached to 
behaviors by the behavior ID, having identical IDs allows you to attach the same 
rule to behaviors from different time periods. The following graphic shows an 
example of behaviors with the same ID.

The following graphic shows the behavior table, BEHAVIORS, for the Baby Bank 
model:
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The following graphic shows how a behavior table is related to other files:

Period Dimension
The period dimension table defines the time periods used in a model. Depending on your 
business reporting needs, you may have more or fewer levels in the period hierarchy. A 
period dimension table can contain the following fields:
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Name

Maximum

Length Description

ID Char 32 The identifying value for the period

Note: The name must be ID.

L1_Scenario Char 32 The top-level dimension member value (for example, Actual 
or Budget)

L2_Year Char 32 The second-level dimension member value (for example, 
2008)

L3_Quarter Char 32 The third-level dimension member value (for example, 
2008_Q4)

Note:

• The order of the columns is significant.

• The name of the columns is arbitrary, except for ID.

• The number of levels is arbitrary.

The following graphic shows the period dimension table, DIM_PERIOD, for the Baby 
Bank model:

Custom Dimensions

Overview
A definition table must be loaded for each dimension used in the SAS Profitability 
Management model and in your transactional tables. Transaction tables have a column 
for each custom dimension defining the crossing where transactional values are 
collected. All dimension names must be a single word.

Note: For every custom dimension, the name of the ID column must be ID. The names 
of the other columns are your choice.

The Baby Bank model contains the following custom dimensions:

• Channel

• Customer

• CusType

• Product

• Region.
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DIM_CHANNEL
The following table shows the channel dimension. It is a one-level table that defines the 
following channels:

L1_Channel

ATM

BRH

Call Center

The following graphic shows the entire table contents:

DIM_CUSTOMER
The following table shows a portion of the contents of the DIM_CUSTOMER 
dimension. You can see that the table defines two types of customers: personal and 
bsiness. For personal customers, the table contains both last name and first name. For 
business customers, the last name contains the name of the business, and the FirstName 
field is blank.

L1_Type L2_LastName L3_FirstName

Personal Adcock James

Farm Peter T.

Aden Shelly

Business Logic Consulting

Metrogas SA

FASHBI Worldwide

The following graphic shows part of the contents of the DIM_CUSTOMER table:
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DIM_CUSTYPE
The following table represents the contents of DIM_CUSTYPE. It shows the levels in 
the dimension.

L1_CType L2_CType

Personal Retail Consumer Banking

Small Business Banking

Business Private Banking

Corporate Banking

The following graphic shows the entire contents of DIM_CUSTYPE:

DIM_PRODUCT
The follow table represents the contents of DIM_PRODUCT:

L1_Product L2_Product

Credit Products Secured/Mortgages

Unsecured
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L1_Product L2_Product

Deposit Products Checking

Recurring

Savings

Term

Fee-Based Products

Other Products

Revolving Credit Products Credit Cards

Overdrafts

Third-Party Products

The following graphic shows the entire contents of DIM_PRODUCT:

DIM_REGION
The following table represents only a portion of the DIM_REGION dimension. It is 
included here to help you understand the level structure. The region dimension has four 
levels.
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Area Country State City

North America Canada Ontario Don Mills

Metcalfe

Quebec St. Hubert Quebec

St. Laurent

Town of Mont Royal

Saskatchewan Sheffield

Mexico Coahuila Saltillo

Mexico Cuauhtemoc

Colinia Granada

Polanco

South America Brazil Brazil Uberlandia - Mg

Pe Brazil Itapissuma

Sao Paulo Ribeirao Preto

Sao Paulo

Costa Rica Costa Rica San Jose

Ecuador Ecuador Guayaquil

Uruguay Montevideo Montevideo

Venezuela Caracas Altamira

The following graphic shows the corresponding part of the actual table contents:
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Rule Definition Table

Overview
A rule provides

• selection criteria that determine which rows are selected in the transaction tables for 
calculation of values (revenue or cost).

• a driver formula that provides the calculation necessary to assign an amount for the 
source values (cost or revenue) from the behavior table to selected records in the 
transaction tables.

Rules can be defined through an interactive method in the SAS Profitability 
Management client user interface, or they can be imported from a source table using the 
appropriate rules definitional syntax to provide the selection logic and the driver 
quantities.

The rule definition table contains the following fields:

Name

Maximum

Length Description

TableGroup Char 64 The name of the transaction table group to which the 
assignment rule will be applied

AssignmentRule Char 64 The name of the assignment rule; this must be unique 
within the model

SelectionCriteria Char 1024 The expression defining the filter logic

DriverFormula Char 1024 The formula defining the calculated quantity
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Note:

• The order of the columns is arbitrary (you identify them during import).

• The name of the columns is arbitrary (but, if you use these names, they are 
automatically mapped during import).

The following graphic shows the rule import table, RULES, for the Baby Bank model:

Rule Selection Criteria

Overview
When you define a rule, you select columns in a transaction table and specify conditions 
on those columns for a row to be selected.
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The following table shows what sort of conditions you can specify depending on the 
type of column that you select:

Table 15.1 temp title

If the selected column is: You can use the following operators:

Text =, not =

match Behavior

Numeric =, not =, <, <=, >, >=

match Behavior

Dimension is child of

match Behavior

Instead of selecting columns from a drop-down list, you can simply type a SAS Boolean 
expression into the selection criteria field.

Following is an example of a SAS boolean expression that you would have to type into 
the selection criteria field.

( IF customer ='C00650' THEN (0.54*Distance) ELSE (0.23*Distance) ) > 1000

Note: Every field referenced in such an expression is in the transaction table.

Match Behavior
Operators MatchColumns

And

Syntax MatchColumns(Transaction(column_name), Behavior(column_name))

Example MatchColumns(Transaction(Product), Behavior(Product))

The match Behavior operator enables you to compare fields between the behavior table 
and a transaction table. The selection criteria are met when the value of every matching 
column in the transaction table row equals the value of the corresponding matching 
column in the behavior table row.

For example, Product in a transaction table can have a corresponding matching Product 
column in the behavior table. Note that the Product field in the behavior table is not a 
required field. You can add additional fields to the behavior table for matching purposes.

Both text and numeric column types are supported for matching fields. You can combine 
multiple match behaviors with the AND operator.
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Is Child Of
Syntax IsChildOf (source column, [dimension table].[value])

Example IsChildOf(channel, '[dim_channel].[ATM]')

Example IsChildOf(channel,'[dim_channel].[ATM]') And 
IsChildOf(product,'[dim_product].[deposit products].[checking]')

The IsChildOf operator allows you to select from any point in a dimensional hierarchy 
tree, and All children of that hierarchy are selected as matching. In the following 
graphic, these selection criteria choose Secured Mortgages (SCR) and Unsecured (UCR) 
because they are both children of Credit Products (and are in the ATM channel):

IsChildOf(Product, '[DIM_PRODUCT].[Credit Products]') AND 

IsChildOf(Channel, '[DIM_CHANNEL].[ATM]')

Note: This rule does not exist in the Baby Bank tutorial model. It is shown here for the 
purpose of illustration.
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Rule Driver Formula

Overview
The result of a driver formula is the driver quantity. The driver formula can be based on

• a single numeric property

• multiple numeric properties

• a single entered value

• a SAS numeric expression.
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Single Numeric Property
Example AMT

Multiple Numeric Properties
Example COUNT * .05 + 

AMT * .01

Single Entered Value
Example 15

SAS Numeric Expression
The driver formula can consist of any SAS numeric expression. Columns referenced in 
the formula must be in the input transaction table.

Example MAX(Requests, Complaints)*.25

Example EUROCURR(AMT, eur , frf )

Example IF CustID ='C00650' THEN (0.54*Distance)

ELSE IF CustID ='C00692' THEN (0.74*Distance)

ELSE (0.23*Distance)

Note: The parentheses after the ELSE operator are required because ELSE 
binds tighter than the * numeric operator (omitting the parentheses would result 
in the expression being parsed differently than intended).

Rule/Behavior Associations
The association table correlates rules with behaviors. Each rule can be used by multiple 
behaviors, but each behavior can only have one rule. The association process can be 
done interactively in the user interface or the associations can be defined based upon an 
import table to load.

The rule association table contains the following fields:

Name

Maximum

Length Description

BehaviorId Char 32 The ID of the behavior table row

TableGroup Char 64 The table group to which the rule is applied

AssignmentRule Char 64 The name of the associated assignment rule. This name 
must be unique within the model
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Note:

• The order of the columns is arbitrary (you identify them during import).

• The name of the columns is arbitrary (but, if you use these names, they are 
automatically mapped during import).

The following graphic shows the rule association table, ASSOCATIONS, for the Baby 
Bank model:

Report Hierarchy

Overview
The report hierarchy table defines the dimension hierarchy for drilling down in profit 
and loss reporting. The number of levels in the hierarchy is a critical model design 
decision, and it is subject to the ultimate reporting needs of the business. A model can 
have multiple report hierarchies.
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The report hierarchy table contains the following fields:

Position Name

Maximum

Length Description

1 ID Char 32 The ID of the behavior table row for this member

Note: The name of the ID column must be ID.

2 L1_Profit Char 32 1st level dimension members for the hierarchy

3 L2_Profit Char 32 2nd level dimension members for the hierarchy

4 L3_Profit Char 32 3rd level dimension members for the hierarchy

5 L4_Profit Char 32 4th level dimension members for the hierarchy

6 L5_Profit Char 32 5th level dimension members for the hierarchy

Note:

• The order of the columns is significant.

• The name of the columns is arbitrary, except for the ID column.

• The number of levels is arbitrary.

The following graphic shows the report hierarchy table for the Baby Bank model. Notice 
that it is ragged—different items have different drill-down depths.

Report Hierarchy 137



The report hierarchy table defines the dimension hierarchy for drilling down into the 
profit and loss report. The number of levels in the hierarchy is a critical decision in 
model design and is subject to the ultimate reporting needs of the business.

Report Hierarchy and the Resulting Report
In the following graphic, you can see how the columns in the report hierarchy relate to 
the columns in the display table of a summary report:
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Behavior Table and Report Hierarchy
The following graphic illustrates the relationship between the behavior table and report 
hierarchy. In it, you can see that items in the behavior table occur at the lowest level in 
the report hierarchy table. Because the hierarchy can have different depths at different 
places, this means that the behavior table items can occur in different columns (different 
depths) in the report hierarchy table. In short, the report hierarchy table is ragged 
(variable length rows).

Also, note that intermediate levels can correspond to custom dimensions (for example, 
the channel and product dimensions at levels 3 and 4) but they do not have to. For 
example, interest income and interest expense (in the first six rows of the report 
hierarchy table) have no existence outside the report hierarchy table itself.

Report Hierarchy 139



It is also important to note that some rows in the report hierarchy have no corresponding 
row in the behavior table (although every row in the behavior table has a corresponding 
row in the report hierarchy). For example, the row with the ID of 23000 in the report 
hierarchy has no corresponding row in the behavior table. That row in the report 
hierarchy serves to group the items logically below it in the hierarchy.

Report Layout

Overview
The report layout defines the calculation logic for the profit and loss statement. The 
report layout controls how the OLAP viewer displays the cube when it is first opened. 
More specifically, the report layout determines:

• The order in which columns are displayed

• Whether fields are initially displayed expanded or collapsed.

Note: The OLAP viewer always shows the highest level of a dimension. The report 
layout determines to what level the highest dimension is expanded when the 
report is initially opened. A user can navigate the dimension, expanding and 
collapsing it at will.

A report hierarchy can have multiple report layouts so that you can create different 
reports from the same data.

A report layout table contains the following fields:
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Positi
on Name

Maximu
m

Length Description

1 ID Char 32 The ID of the behavior table row for this member

2 Name Char 32 The name of the behavior for display on the report

3 Formula Char 255 For calculated rows, the formula for the calculation based 
on the IDs.

The formula can include addition, subtraction, 
multiplication, and division (+, -, *, /).

Note: Formula fields must not also appear in the report 
hierarchy.

4 RowOrde
r

Numeric 
8

The position of the row in the profit-and-loss report

Note:

• The column names must be exactly as shown.

• The order of the columns is arbitrary.

The following graphic shows the report layout table for the Baby Bank model.

Report Layout and the Resulting Report
The report layout controls how the OLAP viewer displays the cube when it is first 
opened. You can see in the following graphic that the report layout table controls:

• the order in which columns are displayed. REPORTLAYOUT causes income 
variables to display before expense variables.

• whether dimensions initially display expanded or collapsed. You can see in the 
following graphic that the Servicing Effort dimension is displayed collapsed because 
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it is included in REPORTLAYOUT without any of its children showing. By contrast, 
the Interest Income dimension is displayed expanded to level 2 because its children 
(Credit Card Interest Income, Loan Interest Income, Mortgage Income) are included 
in REPORTLAYOUT but not the parent, Interest Income.

Note: The OLAP viewer always shows the highest level of a dimension. The report 
layout determines to what level the highest dimension is expanded when the 
report is initially opened. A user can navigate the dimension, expanding and 
collapsing it.

• totals. For example, line 4 of the report layout displays a total whose formula is 
[10001]+[10002]+[10003] (that is, line 1 + line 2 + line 3).

Let's take a closer look at how the report layout determines whether dimensions are 
initially displayed expanded or collapsed. The OLAP viewer always starts at the highest 
level of a dimension. The report layout specifies to what level that dimension is 
expanded when the report is initially opened.

The following graphic shows a report layout that causes the report to be collapsed up to 
the highest level of the Servicing Effort dimension. Notice that Servicing Effort has five 
hierarchical levels in the report hierarchy. The report layout specifies only the highest 
level—Servicing Effort. Therefore the resulting report shows the Servicing Effort 
dimension completely collapsed.
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By contrast, the next graphic shows the report layout specifying an intermediate level of 
the Servicing Effort dimension. Consequently, in the resulting report, Servicing Effort is 
partially expanded down to the level specified in the report layout. By clicking the plus 
sign or down arrow, a user can navigate to lower levels of the Servicing Effort 
dimension.
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The following graphic shows another dimension, Interest Income, that is fully expanded 
in a report. The Interest Income dimension has only three members at its lowest level. In 
the following graphic, you can see the effect of specifying, in the report layout, the 
lowest level members of the Interest Income dimension. It fully expands that dimension 
in the resulting report.

Note: To expand a dimension fully in a report, specify in the report layout the lowest 
level members of the dimension—regardless of how many levels are in the 
dimension hierarchy.
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Summary: Behavior to Hierarchy to Layout to Report
The following graphic summarizes the relationships among the behavior table, report 
hierarchy, report layout, and resulting OLAP report. Note that the ID in the behavior 
table matches the ID in the report hierarchy table and the report layout table. SAS 
Profitability Management also currently requires that the associated name in the report 
hierarchy table match the name in the report layout table, but the primary key is the ID 
field.
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Transaction Tables

Overview
A single SAS Profitability Management model can have multiple transaction tables, 
depending upon how the data is collected for your corporation. A table group is a set of 
tables sharing the same schema (same columns with the same field definitions). In a 
table group, each table represents one period of the period table.

There must be a separate transaction table for each period in the model. For a single SAS 
Profitability Management model, multiple table groups will likely be defined. It is also 
likely that multiple rules will use the same source table group.

Transactional table layout is affected by the rules definition process (filter logic and 
driver logic). There are three critical aspects to every transaction table: dimensional 
signature, filter criteria selection logic, and quantities for calculation.

A transaction table contains the following columns and must conform to the following 
rules:

• Each column must have the length shown.

• The position of columns is arbitrary.

• The name of columns is arbitrary.
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• The number of columns in a transaction table is arbitrary.

• A transaction table can contain other columns not specifically used by SAS 
Profitability Management.

Name Maximum

Length

Description

Dimensions

(1 to n)

Char 32 Each value identifies the row (in a custom dimensions 
table) for this transaction.

The number of dimensions is optional (minimum 1).

Driver quantities

(1 to n)

Numeric 8 A rule's driver formula uses these values to calculate the 
driver quantity for a transaction.

The number of columns is optional (minimum 1).

Optional columns

(0 to n)

Optional You can add any number of optional text or numeric 
columns of any length to a transaction table.

For example, you can use an optional column for matching 
fields in a behavior table.

The following graphic shows the transaction table, LOAD_TRANS_Q4A, and how each 
of its columns is identified as either text, numeric, or a dimension member. You can see 
that each column that is identified as a dimension member contains values that 
correspond to values in the ID field of the corresponding dimension table.
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ABMCost Group
The ABMCost table group consists of the following two transaction tables:

• LOAD_TRANS_Q4A for the fourth quarter actual period

• LOAD_TRANS_Q4B for the fourth quarter budget period.

The schema for the ABMCost group consists of the following fields:

Field Name Description

1 CustID ID of customer dimension

2 Product ID of product dimension

3 CustType ID of customer type dimension

4 Region ID of region dimension

5 Channel ID of channel dimension

6 AssignmentRul
e

Text string for use in filtering rows with that string. Rows that are 
selected are assigned the behavior cost.

7 Count Value of 1, used in driver

8 AMT Number of occurrences, used in driver

The following graphic shows a portion of the contents of LOAD_TRANS_Q4A:
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CallCenter Group
The CallCenter table group consists of the following two transaction tables:

• CALLCENTER_Q4A for the fourth quarter actual period

• CALLCENTER _Q4B for the fourth quarter budget period.

The schema for the CallCenter group consists of the following fields:

Field Name Description

1 Product ID of product dimension

2 CustType ID of customer-type dimension

3 Region ID of region dimension

4 Channel ID of channel dimension

5 Communication Number of calls
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Field Name Description

6 Complaints Number of complaints

7 Inquiry Number of inquiries

8 Requests Number of requests

9 CrossSell Number of sales calls

10 Offer Number of offers

11 Count A value of 1 indicates an evenly assigned item

The following graphic shows a portion of the contents of CALLCENTER_Q4A:

Revenue Group
The revenue table group consists of the following two transaction tables:

• REVENUE_Q4A for the fourth quarter actual period

• REVENUE _Q4B for the fourth quarter budget period.

The schema for the Revenue group consists of the following fields:

Table 15.2 Revenue Group

Field Name Description

1 Channel ID of channel dimension

2 CustID ID of customer dimension
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Field Name Description

3 Product ID of product dimension

4 CustType ID of customer type dimension

5 Region ID of region dimension

6 AMT Calculated specific revenue

7 ID Behavior ID for revenue items

The following graphic shows a portion of the contents of REVENUE_Q4A:

Data Model Definition
The following graphic shows the the tables that make up the data model, with the 
columns for each field, and the relations among them.
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A Complete Model
The following graphic shows all the elements of a complete model, even smaller than 
Baby Bank. This one can be called Babies Bank. It calculates expenses for two babies, 
Lea and Axelle, during the course of two years (only one of which is shown here).
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Introduction
The Baby Bank model in this tutorial is intended to be small enough to be easily 
understood and yet large enough to suggest a realistic business model. Although the 
tables are only a fraction of the size of the tables of a real business model, they are still 
too large to see each one easily in its entirety, much less all of them at once. By contrast, 
this chapter develops a model that is so minimal that you can see all of the tables in their 
entirety at the same time. The model represents the budget of a single individual. And, 
instead of showing an entire personal budget, it shows only salary minus tax withholding 
and food expenses. The following graphic shows the final report to be produced.
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Step 1: Calculating Gross Monthly Salary
We create this model step by step. Once the model has been completely developed, we 
will examine the relationships among its tables.

As a first step, we create a minuscule model to produce a report showing only monthly 
gross salary. In this model, the annual salary is contained in each month's transaction 
table. The rule, Monthly Salary, divides the annual salary by 12 to calculate the salary 
for a month. By including the annual salary in each month's transaction table, the annual 
salary can change from one month to the next. We do not show any change in the three 
months represented here.

The following graphic shows all the tables that make up this minuscule model and the 
resulting summary report.
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Step 2: Deducting Taxes
In a second step, we complicate the model slightly to subtract the tax withheld from each 
monthly salary to produce a report showing both gross salary and net salary. The rule to 
calculate the withholding once again calculates the monthly salary and then multiplies 
the product by .20 for a 20% deduction.
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The following graphic shows all of the tables that make up the model and the resulting 
summary report.
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Step 3: Completing the Model

The Entire Model at a Glance
Next, we complete the model to produce the report promised at the beginning of this 
chapter. The following graphic shows all of the tables that make up the model. Because, 
up to now, we have not shown transaction tables for the months of April through 
December, we have dropped those months from the behavior table—and consequently 
from the association table, which associates behaviors with rules. This makes it easier to 
see each entire table.
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Having seen the model in its entirety, we can take a closer look at its constituent tables.

Behavior Table and Report Hierarchy
Now we can look at the tables in detail. First, consider the relationship between the 
behavior table and the report hierarchy. For every row in the behavior table, there is a 
corresponding row in the report hierarchy. However, there are rows in the report 
hierarchy for which there is no corresponding row in the behavior table. These rows 
(such as the Fd row) establish higher levels in the hierarchy. Such rows can establish 
intermediate levels, but the report hierarchy shown here has no intermediate levels.

Note that multiple rows in the behavior table have the same ID. The ID identifies the 
period in which a revenue or expense is incurred, and of course there are multiple 
revenues and expenses in a single period.

For convenience of reference, we also show the report layout and resulting summary 
report.
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Report Hierarchy, Report Layout, and Behavior Table

Overview
A model can have multiple hierarchies, and each hierarchy can have multiple layouts. In 
this section, we look at the relationship between our model's report hierarchy, behavior 
table, and three alternative report layouts.

First Report Layout
ln the following graphic, every row in the report layout that is not a formula row has a 
corresponding row in the report hierarchy. However, not every row in the report 
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hierarchy has a corresponding row in the report layout. And some of the rows in the 
report layout have a corresponding row in the behavior table.

However, not every row in the report layout has a corresponding row in the behavior 
table. There are three types of rows in a report layout that do not have a corresponding 
row in the behavior table:

• Formula rows (for example, the row with the formula [GrossSalary]-
[Deduction])

• Label rows (A row whose formula is "." creates a label in the report. This particular 
report layout does not contain any label rows.)

• Rows that correspond to rows in the hierarchy table that are not leaf rows (for 
example, the row with the ID of Fd). 

For clarity, let's view the report hierarchy as a tree rather than as a table. The 
following graphic shows the report hierarchy as a tree.
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Notice that GrossSalary, Deduction, and Fd are all siblings. However, only 
GrossSalary and Deduction are leaf nodes. Fd has five children, so it is not a leaf 
node and, therefore, not in the behavior table. The behavior table contains nothing 
but leaf nodes.

Second Report Layout
The following graphic shows the same report hierarchy with an alternative report layout. 
This layout has only one row that has a corresponding row in the report hierarchy—the 
Fd row. Whereas every row in the report layout that is not a formula or label row has a 
corresponding row in the report hierarchy, not every row in the report hierarchy has a 
corresponding row in the report layout. And, again, because the Fd row in the layout is 
not a leaf node in the hierarchy, it is not represented in the behavior table.

Because the Fd row in the report layout is not a leaf node in the report hierarchy, the 
report opens with that item collapsed. In the following graphic the Food row is initially 
displayed collapsed, and when a user clicks on the plus sign, the children of the Fd row 
are displayed.
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Third Report Layout
In this final example we look at a third alternative report layout. In this layout, all the 
non-formula rows are leaf items in the report hierarchy. Thus, not only do these rows in 
the report layout have corresponding rows in the report hierarchy, they also have 
corresponding rows in the behavior table. And, again you can see that not every row in 
the report hierarchy has a corresponding row in the report layout—GrossSalary and 
Deduction in the report hierarchy do not have corresponding rows in the report layout.

Also, notice the effect on the summary report of including leaf nodes in the report 
layout. Initially the report displays with these items expanded. In general, a report opens 
expanded to the lowest level that is represented in the report layout. If there are levels in 
the report hierarchy lower than the lowest levels in the report layout, then those levels 
must be expanded by a person viewing the report to be visible.
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Behavior Table, Rule Association Table, and Rules
Looking at the behavior table, the rule association table, and the rules table, we can see 
that every row in the behavior table is associated, via the rule association table, with a 
row in the rules table. Multiple behaviors can be associated with the same rule.

The rule, FoodExpense, provides a good example of the use of Match Behavior in the 
selection criteria.To calculate how much was spent at Weaver Street restaurant, for 
example, it is not sufficient to select all transactions that are Food expenses. You must 
select only those Food expenses that were incurred at Weaver Street. This is 
accomplished by using the selection criterion 
MatchColumns(Transaction(Provider), Behavior(ID)). For the month of 
January, the behavior whose ID is ws (Weaver Street) matches two transactions whose 
value in the Provider column is ws.

You can see how each row in the output transaction table is produced by the application 
of a rule to a row of the input transaction table.

Note: This example of MatchColumns is atypical because the column in the behavior 
table being compared for a match is one of the required behavior table columns. 
Usually, the column is one that you will have specifically added to the behavior table 
to enable a match comparison.
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Dimension Table and Transaction Tables
The model includes a custom dimension, dim_food, which contains more information 
about food expenses than the report hierarchy. The Provider column in each row of the 
transaction table points to one of the IDs in the dimension table.
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Thus, because rows in the transaction table can be identified as belonging to a custom 
dimension, you can open that dimension table in the cube viewer, SAS Web Report 
Studio, to see details regarding the dimension. The following graphic shows the report 
that results when you select Dim Food in the cube viewer. In the report you can see how 
much was spent on what type of restaurant—vegetarian, Mexican, Chinese—information 
that was not available in the original report.
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An Additional Hierarchy and Layout
Notice that in the report on the Food dimension (shown again here) there is no monthly 
total for food expenses. Unlike with a report hierarchy, with a custom dimension there is 
no associated report layout that contains rows to perform a calculation.

If you want to perform a calculation on the information contained in a dimension table, 
then you can create an additional report hierarchy and report layout for the model. Each 
model can have multiple hierarchies and multiple layouts to produce multiple reports. 
The following graphic shows an additional hierarchy and layout used to create a report 
that shows only food expenses and the total spent each month.

As you can see, the report hierarchy duplicates much of the information in the custom 
dimension in order to produce a report showing total food expenses. Even though this 
example does not show it, the custom dimension can contain additional information 
(such as the tip left at each restaurant or the number of diners at each meal) that is not 
incorporated into the report hierarchy. Thus, even though the report hierarchy might 
contain much of the information of a custom dimension, you might still want to open the 
custom dimension in SAS Web Report Studio to see more information.
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Changing the Period Dimension
Notice that the reports show no total for the year. To display an annual total, you can 
change the period dimension by adding a column and row for the year, as shown in the 
following graphic.
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The following graphic shows two views of the original report using the new period 
dimension. At the top of the graphic you can see the collapsed report showing the total 
for the year. And, at the bottom of the graphic, you see the expanded report showing the 
total for each month.

In the following graphic, two views of a report show the additional hierarchy and layout 
that concentrate on food expenses. At the top of the graphic is the collapsed report 
showing only the total expense for each type of restaurant for the entire year. At the 
bottom of the graphic is an expanded report showing each individual restaurant and the 
total for the month.
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An Alternative Behavior Table
This section shows a model that uses an alternative behavior table. The behavior table 
that we have used up to now contains much information on food expenses, with a row 
for each possible restaurant expense and a row for eating at home. This level of detail in 
the behavior table is appropriate if you want to see such data in the resulting OLAP 
report. A behavior table represents the lowest level of drill down in an OLAP view. 
However, if you want to see only total food expenses, then the behavior table used up to 
now is too complicated. It can be replaced by the alternative behavior table (shown in 
the following graphic) that contains a single row for each month of food expense. The 
graphic also shows a new report hierarchy with the alternative behavior table and a new 
report layout—each of which is displayed next to the corresponding original report 
hierarchy and report layout.
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The following graphic shows the summary report that results from the alternative 
behavior table, report hierarchy, and report layout as contrasted with the original 
summary report resulting from the original behavior table. Notice that detailed 
information on food expenses is missing from the new report because that information is 
missing from the behavior table.
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The following graphic shows all of the tables that make up the new model containing the 
alternative behavior table as well as the resulting summary report.
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Notice that in this model a user can open a report showing the food dimension, 
dim_food, as discussed in “Dimension Table and Transaction Tables” on page 168.

The same report is also available in our previous model because both models contain 
exactly the same custom dimension, dim_food. This food report's availability illustrates 
the fact that even though some information may be missing from the behavior table, it 
can be accessed in custom dimensions, which are also viewable as OLAP views.
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Baby Bank Conclusions
You have successfully created a SAS Profitability Management model, calculated 
transaction tables, and generated cubes. You have reviewed profit and loss reports at 
both a summary and a detail level. You have reviewed those results to draw conclusions 
about your customers behavior and the action Baby Bank can take to focus specific 
attention on custerm needs and how they impact the corporate profitability of Baby 
Bank. Baby Bank can now analyze its customers, channels, products, customer types, 
and regions to plan for a successful and profitable future.

SAS Profitability Management enables organizations to use more accurate profitability 
measures to make better decisions for customers, products, and channels. With SAS 
Profitability Management, decision-makers can define and redefine the segmentation 
reports that they need on the fly. SAS Profitability Management enables business 
managers to track the profit performance of customer groups or individual customers, 
product groups or individual SKUs, channels or specific branches - presenting drill-
down and at-a-glance views into revenue, cost, and other metrics so they can identify 
and investigate problems that can improve the bottom line.

Additional Features
Enhance your SAS Profitability Management Solution with

• SAS Activity-Based Management enables strategic and operational decisions that 
maximize profit, reduce costs, and streamline processes by determining the cost of 
those processes and the profitability of products, customers, and business segments. 
In SAS Activity-Based Management, you can mark accounts as behaviors and then 
publish the behaviors for use in SAS Profitability Management.

• SAS Customer Profitability for telecommunications is a component of SAS 
Telecommunications Intelligence Solutions, a Suite of integrated solutions that are 
built on an enterprise data architecture optimized for telecommunications providers.

179



• SAS Customer Intelligence for Banking can help you understand an individual 
customer's behavior at every touch-point throughout the life cycle of the relationship. 
By integrating data across channels, product silos, and external data and market 
sources, you create a holistic picture of the current, potential, and future value that 
each customer delivers, as opposed to fragmented facts on customer risk, behavior, 
account activities, and operational costs. Using predictive analytics, you can forecast 
customer behaviors such as attrition and credit and load risk so you can devise more 
effective cross-sell and up-sell strategies.

What to Do Next: Useful Links
• SAS Worldwide Web for links to everything SAS

http://www.sas.com/

• SAS Worldwide Training

http://support.sas.com/training/index.html

• BetterManagement - for useful business domain white papers and web casts

http://www.bettermanagement.com/

• SAS Solutions - Links to other powerful business solutions from SAS

Focused Solutions for your Business Challenges: To lead with confidence and 
outpace competitors, you need to make accurate decisions faster than ever. SAS 
equips your organization for success by helping you answer more questions, for 
more people, across more departments than any other analytic applications suite 
provider.

http://www.sas.com/solutions/index.html

• SAS Business Intelligence:

SAS Business Intelligence gives you the information, when you need it, in the format 
you need. By integrating data from across your enterprise and delivering self-service 
reporting and analysis, IT spends less time responding to requests, and business users 
spend less time looking for information - so more time is spent on making better, 
more informed decisions

http://www.sas.com/technologies/bi/index.html

• SAS Analytics:

SAS Analytics give you THE POWER TO KNOW how to integrate data from across 
your enterprise and then quickly transform that data into shared insights. We offer a 
comprehensive suite of analytics software to help you reduce uncertainty, predict 
with precision, and optimize performance

http://www.sas.com/technologies/analytics/index.html

• SAS Merchandise Intelligence

Only SAS Merchandise Intelligence provides real intelligence at every step of the 
merchandising life cycle. With this collection of software and services, you can 
maximize the profitability of the merchandising process while improving customer 
loyalty and satisfaction levels. Retailers get reporting, planning, forecasting, and 
optimization at critical points through the planning process, which leads to faster and 
better decisions.
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http://www.sas.com/industry/retail/merchandise/index.html

• SAS Customer Intelligence

Only SAS Customer Intelligence provides the vital knowledge needed to help 
organizations build an integrated platform for enterprise marketing management. 
With SAS Customer Intelligence, campaigns and programs implemented across 
channels will be effective, consistent, and timely. They will target the right 
customers with the right offers. And with the power of SAS predictive analytics, you 
can be confident that actual results will match predicted ones, even before you spend 
anything on a new campaign.

http://www.sas.com/solutions/crm/index.html
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